Verilog — pfiklad — behavioralni popis

module gates (input [3:0] a, b,
output [3:0] y1, y2,y3, y4, y5);

assignyl = a&b; I/ AND
assigny2 = a| b; /Il OR
assign y3=a” b; //XOR

. . ) S B
assign y4=~(@é&b); // NAND B ) I ==
. y3[3:0]
assignys5 = ~(a|b); //NOR
(@30 L HBA M~ [ B
: —_ [3:0] []3:0] ya4[3:0] =
endmodule bi3:0] — - L- —
y1[3:0] y4[3:0]
TR —
[3:0] T : ; )
BY | 0 E;“‘/c R e
y2[3:0] y5[3:0]
e T —
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SE Project Navigator

'Fileﬁdit Wiew  Project  Source  Process  Tools  Window  Help

PDPEHL ¥ DO X 0o ML LXX2RAC

| Getting Started T~—_ B x|

No projectis open

Select one of the buttans below ta get started. Also,
check out the "what's New" help page, available from
the "Help" menu.

|| Console 08 X
| 2 E—— &
Consale | Errors || Warnings |




Zalozenl noveno projektu v prostredi Xilinx ID

2 ISE Project Navigator
File Edit  Vigw Froject  Source  Frocess  Tools  window  Help

DPEHP L UDEXwa|APEXX 2R N B el

| Getting Started

Z New Project Wizard

No project is open Create New Project

Specify project location and tvpe,
Select one of the buttons below to get started
check out the "what's Mew" help page, awvailab
the "Help" menu.

Enter a name, locations, and comment for the project

o . |
Open Project,.. Locatian: |C:". ¥\ | E]
AN

Open Example. ., Description:

Project Browser. .,

Pojmenujeme a vybereme
adresar pro ukladani
projektu

-Select the tvpe of top-level source for the project

Top-level source type:

HOL |
| Console 08 %
] i | =
Consale | Etrars ” Warnings |




P ——
Zalozeni novéeho groiektu \Y; Erostfedi Xilinx IDE

2 IS_E Pro jec}_ﬁa_ﬁgfu T

Fie Edit Wew Project Source. Frocess  Tools  Windmw  Help
DPEDP L XDEX|ve 22X PRIARE NG E £

| Getting Started &= New Project Wizard

No project is open Device Properties ]

Specify device and project properties,
Select one of the buttans below ko get started

check out the "what's Mew" help page, awvailab
the "Help" meny. Select the device and design Flow For the project /
{
sl y <
Meww Project. .. _Eroperty Marme e T
Product Categary all
Open Project... Family | utomative 9500:L
Open Example. . E_)evice Automatic xa9500:x]
Package [
Project Browser. ., Speed e )
Top-Level Source Type HDL
Sy_nthesis Tool #3T (WHOLMerilog)
Simulatar 15im (¥HOLVerilog) N
Preferred Language |werilog \
Manu@l Compile Crder ] ~
Vybereme simulat
Enable Enhanced Design Summarsy y e re e SI u a
Enable Message Filkering | b It t' ~ |
F Display Incremental Massages ] n e O a e rn a Ivn e |
| Consale . ++ [ 5 %
[ < Back J [ Mexk = j [ Cancel ]
]l I [ = .




£ ISE Project Navigator - Wisclient\DMmp2Xxilinxprvni_cvicenilprvni_cviceni.xise

File:

B fn Ee ) G0 b0

Edit

Wie

DD

urces For: |In

I

Hierarchy

- B wc3sS

£Z] Add Source...
add Copy of Source, .

Toals

Source  Process Windomw  Help

i APEX PRI

Mew THBLbrary. .
taral Compile Order

Zleanup Project Files., ..

Archive, ..

Take Snapshot...

Zpen Existing Snapshat, .,
Generate Tol Script. ..

H 28| 28 8E |«

Mo single desic

g

e

Design Goals & Strateqies. ..

Source Conkral 3

i Design Summary/Feparts
Diesign Properties. .

| Design [ Files " Libraries

|C0nsu:ule —

=2

& | o
Consols | Errors ” Warnings |

Add a new source to the project
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Al AL FAYTATATEANATAA\Y/IATA I YE AT'EA 'Y I YT ED I IV

== ISE Project Navigator - Wtsclient\D\tmp 2\xilinx\prvni_cyiceni\pryni_cviceni.xise

File Edit ‘“iew Project Sowrce Process  Tools Window  Help

NP2 EHP i xDEX v @i A2AAXX 2R

|Design +04 Xl

Sources For: |Implementation

Hierarchy

- a [:rvni_cviceni
o BT wc3s50-5pa20s

£ New Source Wizard

Select Source Type
Select source bvpe, file naple and its location,

/
IP (CORE @enerator 3 Architeckure Wizard)
Schernatic

User Document;

B M Ee R 00 E

Mo single design module is selected, gotiog et R

— . — WHOL Module il
= ﬁ Design Ukilities WHDL Library Eile name: ‘
YHOL Package |pwni_.;.bwd K |
WHOL Test Bench
Locakion:

B | 28| 8 &8 |«

| esclienth Dikrmp 2 «iline: pryni_cviceni /ﬁ

/

LM” Libraries 3 . U m Ilsté n II

|C0nsole +0O& X|
] Add to project
i Mexk = i [ Cancel ]
< Il | 8
.EE_I!'IS.E!!F':_ Etrars " \Warnings |
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ISE Project Navigator - \isclient\DMmp 2\xilinx\prvni_cviceni\prvni_cviceni.xise

File Edit ‘“iew Project Sowrce Process  Tools Window  Help

ODPHG G DB X v o M

|Design +04 Xl
Bj‘ Sources For: |Implementation .
£ Hietarichy - .
REw- [ = Mew Source Wizard
A : ﬂ prwni_cyiceni
o+ i
""" £3 xc3s50-5pq208 Define Module
| ;;;ni;g Specify porks For module,
Module name | prvni_obwod
-
Paort Mame | Direckion Bus MSE L5E N
L a input » |3 o
o Mo single design module is selected_ b input 3 o |
Et e ﬁ Diesign Utilities }fl oukput | 3 o i
= v oukput |» v 3 o
S5 iz |
k bS] output - 3 o |
m v oukput v 3 o |
w5 output v i3 o
i T 1
: input ~|C |
Design Files ” Libraries | input .7 g |
1C0nsule Mas O | +0O& X|
inpuk |=lC] |-
[ < Back, J i Mexk = i [ Cancel ]
< i | e
.EE_I!'I.S.E!!!?:_ | Errors " \Warnings |
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File  Edit

View  Project Source

Process  Taols  wWindow  Help

D2EH& -

DD X v #:

|Design

Sources For: |Implementation

B 5B

]

Hierarchy
@ Prvni_cviceni

#£3550-5pg208

£ New Source Wizard

Summary

Project Mavigator will create a new skeleton source with the Follmwing specifications,

Add ta Project: ves

Source Type: Yerilog Module
Source Mame: pryni_obwod. v

088 28 |«

Design Ukilities

Mo single design module is selected, Maodule name: pryni_obeyod

=

Port Definitions:

Design Files ” Libraries

Bus:
Bus:
Bus:
Bus:
Bus:
Bus:
Bus:

Source Directory: YikbsclienthDitrmp2hudlineg proeni_cviceni

input

input

oukpuk
oukpuk
outpuk
oukpuk
outpuk

Finish

1C0nsule +0O& X|
y -
[ < Back, J [ Finish [ Cancel ]
= i | B
Console | Errors | Warnings |
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Popis tohoto obvodu v prostiedi Xilinx IDE

&= ISE Project Navigator, - C:\Documents and Settings\XPMUser\projects_xilimd\pryni_cviceni\pryni_cviceni.xise - [pryni_obvod.v]

File Edit Wiew Projeck  Source  Process  Toaols  Window  Help -8 X
DPEHG G s DEX wa i AARKXLPRIANZEODDLR BT L]
| Design - <08 X = 1 timescale 1ns / 1lps ~
i Sources for: |Implementation = R I
‘:@ Hierarchy E ¢ Soupany:
= 3 4 /¢ Engi :
Hﬂ 'F'j Prvni_cviceni - 5 i/ R
— | B & xc3sS0-Spa208 = & // Create Date: 00:00:00 0070070000
i wni_obvod (prvni_ob = 2 // Design Name:
] g J/ Module Name: prvni obvod
El 9 // Project Name:
g A 10 // Target Devices:
#
.-. % 11 // Tool wversions: ObraZOVka po
@ 12 // Description: Vg a4 7 v ’
= , | 13 uspesnem VytVOf'enl
e | ¥ % 14 // Dependencies: , .
?3: Processes: pryni_obwod 15 :’;; % noveho prOJektu L
2 " i 7 1A evision:
=L e o g:z:g: Z:im‘:rmepms 17 /¢ Revision 0.01 - File Created
Ut ::+| g Userch'nstraints 18 J/ hdditional Comments:
| : 19 i/
- :: E;}i f;“f:;:ﬁf[):fn 20 FESEIEIEEIIE I I IR BRI
N by P g i 21 module prvni okbwod|
fJ)  Generate Programming File ; =
& ‘:’% Confiqure Target Device &z Hmank G A
ol Z3 input [3:0] L,
24 output [3:0] w1, B
< | o ) ¥ o
!. Design !_!:_i.l?§ I Libraties | = Design Summary (out of dake) ' prvni_obevod,y
Console - 08 %

£ |

Console | Errors || ‘Warnings |

Ln & Col 38 Werilog




Popis tohoto obvodu v prostiedi Xilinx IDE

22 ISE Project Navigator - Wisclient\DXxtmp 2\xilinx\prvni_cviceni\pryni_cviceni.xise - [prvni_obvod.v*]

File Edit Wiew Projeck  Source  Process  Toaols  Window  Help -8 X
DAEF L 4oEXwae LA EXX PR ZEDaisei@c L9
Design _ «o8x & 115 s/ ~
B Saources for: |Implementation Ll = 16 /¢ Revision:
llHierarch = 17 J/ Rewision 0.01 - File Created

& : = 16 // hdditional Comments:

1. =] i i 1

HEJ 'tj prwni_cviceni = 1a 4

= EF =c3s50-5pg20a

- ; ) H0E e e 0 e S S 0 0 e e o 0 O e e e U
m:l prvni_obwod {prvni_obwod, )

21 module prvni_obwod|

o
o
W

50

% 2a input [3:0] =&,
23 input [3:0] b, , , .
g A 24 tput [3:0] vi, D b d .
= il opSani popIisu obvodau.
[« » . [3:0] ?3 : :
26 output : w3, 1 —_ & b .
— A 2 cutput [3:0] w4, aSSIQn y - a y
B 28 output 301 s .
P | Processes: prvni_obvod 29 b aSS I g n y2 —_ a | b y
i . Wi : 30
'\_I: E Design Summary iR eporks a1 assign vl = a ¢ by /7 AND . A
[ Design Utilities i _ ’ g y3 - b "
2= % User Constraints 3z ASSIONLYE = & 1 b; /4 OR aSSI n a ,
i s 33 ass:I.gn ¥3i = a jaH] f4 EOR . _ .
|Edit Process Properties E"‘t Design 34 ass:.Lgn v j wlace Bl gf HAND aSS I g n y4 - ~(a &. b) y
[ f2)  Generate Programming File 22 assllgn ve £ omlen] Bl ER DER .
=] ‘:‘% Configure Target Device G —— aSS I g n y5 - ~ (a | b) ;
a3 %
< 5
i_ Design :_F_”!E? I Libraties | | preni_obyod, v | = Design Summary |
Console +0&F X

Launching Design SummaryyBeport YViewer. .. ==

2 =T
‘ Ztarted : "Launching ISE Text Editor to edit prvni_obwvod.w™. =
|

t

|

L& s
Console Errors || ‘Warnings

Edit the properties for the highlighted process Ln 36 Col 7 Werilog
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Verilog — simulace — Obecne

o Krok prvni — ,zapouzdrit* simulovany obvod do modulu
bez vstupu a vystupu

o Krok druhy - vytvorit vnitfni promenné tohoto modulu
(reg, wire) pro nastavovani vstupu (reg) a sledovani
vystupu (wire) simulovaného obvodu

* Krokt reti — prifazeni vytvofenych vnitfrnich promennych
vstupum a vystupum simulovaného obvodu

» Krok étvrty — specifikace ¢asové posloupnosti stimulu
obvodu
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timescale 1ns / 1ps Verilog — simulace — Obecné
/‘module test(); «—— Zadné vstupy ani vystupy \

p
reg a, b; //vstu . . v - .
_g j by vytvoreni vnitfnich proménnych
wire c;  // vystupy _
- vytvoreni instance
( . . o 2 || simulovaného
nazev_simulovaneho obvodu pojmenovani _instance( obvodu a pirazeni
.a(a), — Z ST ; iteni
() Signaly s teckou pred jménem jsou | | 4 antrnlch ;
.b(b), *——____| ndzvy signdll uvnitt simulovaného promennych, o
.c(c), obvodu, zatimco v zavorkach jsou vstupum a vystupum
) nazvy vnitfnich proménnych simulovaného
\ J
— . obvodu
(initial begin =~ )
a=0: . inicializace vstupu
b=0; - - = -
end ) VSechny always bloky (vicero prikazu pro

Calways #40 a = ~a; jeden always se ohraniCuje mezi begin a
‘ : end) jsou vykonavany soucasne...

[ always #80 b = ~b; |

\.endmodule invertuj b kazdych 80 ns
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Simulace tohoto obvodu v prostfedi Xilinx IDE

1 [2]X]
-

- |5

e x- :';';;f',:.g;{,m B 2emalseiac L9
e ———.1..Project -> New Source, nebo pouzit ikoriu..

Hierarchy = :
S — == New Source Wizard
'F'j prvni_cviceni
=] EE XCSSED'SDQ?DB ) Select Source Type 0 e e e
m:e prvni_obvad (prvni_ob Select source bype, file name and its location,

BMM File
[ IP (CORE Generator & Architecturs Wizard)
Implementation Constrainks File
MEM File

Schematic

N
5
S,
o
(@)
‘4
wn
—
T
@
=
D

AoehH&EEEE SR

User Document ’
?3: Processes: pryni_obwod Yerilog Module LIS
—-\{: b Design Summary/Reports Yerilog Test Fixture |test |

YHOL Module ;
WHOL Library Locatign:

= Design Ukilities

e User Constraints

WHOL Package }'l,'l,tscﬁent'l,D'l,tmp2'|,xilin><1,|:urvni_cviceni | E
|

= #2  Synthesize - ®5T

4 m
s

0 @ #2  Implement Design YHDL Test Bench
fJ)  Generate Programming Fils e
| E’% Configure Target Device 3 . N aZ eV SO u b 0 ru p ro

- . ° o
definici stimulu pro obvod 5

!. Design |_F_||es ,. L|btar|es | E F2n [u ) ful o] fu] [=Tul o
Console +0&F X

: [ Mexk = ] [ Cancel

s
Started : "Launching ISE = =

Launching Design SummaryyBeport YViewer. .. 3

£ |

Console | Errors || ‘Warnings |

Ln 36 Col 7 Werilog




Simulace tohoto obvodu v Erostfedi Xilinx IDE

= ISE Project Navigator - \\isclient\D\imp 2\xilinx\prvni_cviceni\pryni_cviceni.xise - [prvni_obyod.v*]

File Edit Mew Project  Sowrce Process  Tools  Window  Help -8 X
DPEF L DX vwe WA XEX 2R(A2EOa,sei@c L)@
iDesign +0048 X.]I e 15 // o

Sources for: |Implementation vl = 16 /¢ Revision:

Hierarchy - :

— T = Mew Source Wizard

prvni_cviceni

=8 ﬂ XCSfD'SDQ?DB ) Associate Source fffffffffff,’ff’ffffff

e Eu prvni_obvad (prvni_ob Select a source with which to associate the new source,

0 EE W& i E

Processes: pryni_obwod
; Design Summary iR eporks

Cosen Ut Nastaveni asociace (ktery obvod

User Constraints .
Synthesize - 3T h I t )
chceme simulovat..

Generate Programming File
Configure Target Device

EIEIEE:

Lisiatal y d e

N ext ¥ s.z
Design | Fies | Libraries | \

\

|C0nsole +0&F X
[ < Back ] [ Mexk = [ Cancel

~
Started : "Launching ISE - £z T
Launching Design SummaryyBeport YViewer. .. =
W
£ Il | >
Consale | Errors "_Warnings |

Ln 36 Col 7 Werilog

A4M36PAP Pokro €ilé architektury po €itact




Simulace tohoto obvodu v Erostfedi Xilinx IDE

= ISE Project Navigator - \\isclient\D\imp 2\xilinx\prvni_cviceni\pryni_cviceni.xise - [prvni_obyod.v*]

File Edit Mew Project  Sowrce Process  Tools  Window  Help -8 X
DAEP L XDEX v B 2APHEX 2PRI[ABRED2FRBEL):Q
|Design +0048 Xi e 15 // o

Sources for: |Implementation vl = 16 /¢ Revision:

Hierarchy - SR S S

’ 2 T = New Source Wizard

prvni_cviceni

B EJ xc3s5i0-5pa208 _ Summary R PR R PR SN

e Ba prvni_obvad (prvni_ob Project Mavigator will create a new skeleton source with the Following specifications.

Add ta Project: ves

Source Directory: YikbsclienthDitrmp2hdlineg proeni_cviceni
Source Twpe: Yerilog Test Fixture

Source Mame: kesk,y

Association: pryni_obvod

Processes: pryni_obwod

; Design Summary iR eporks
Design Ukilities

User Constraints
Synthesize - 3T
Implement Design
Generate Programming File
Configure Target Device

A8 8E 0 o0e Wi )=

Finish ..
Design _Fili” Libraries | \\
|C0nsole

[ < Back ][ Finish [ Cancel =

Started : "Launching ISE =
Launching Design SummaryyBeport YViewer. ..

< Il | ¥l

Console | Etrars " \Warnings |
Ln 36 Col 7 Werilog
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Simulace tohoto obvodu v prostfedi Xilinx IDE

2 IsE Project Navigator - C:\Documents and Settings\XPMUser\projects_xilinx\prvni_cvicenil\prvni_cviceni.xise - [test.v]

File Edit Wiew Projeck  Source  Process  Toaols  Window  Help . .
D2EB $DDEX|(we BALPEXPR(AIBRE I RGBT L)Q
S | TEa = - = =
i T 8 swmeeew K| Pedpfipravené.. (Netfeba menit)
]2 @ s |
£ R 53 s s v i . o
e 2| s /v 0 e ser siofer | DOPSA@NT VNEJSich stimulu

= 5 \ #100; ) . .
fE T e ¥ ObvOdu (Ize to i 1épe.. Viz str.17):
= I b - aimitia; a = 4'b0000; /I binarné

W
o

Edit Source Properties|

- &0

{: : P.rcucesses: prvni_obvnci . :;' #10015: b - 4l b 1 1 l 1 ;

{: E Design Summary iR eporks

& Design Ultilities & h oz b
2= User Constraints &
- = : A5 #100;
—|&@ P2 Synthesize - X5T . " OO' t e 1 . t k
€2 Inplement Desr = gem 2 o #100; // pozastaveni na jednote
)  Generate Programming File - \ ‘ J .
i W Eonfours ThostDe = 15; /I dekadick
+ ..@ onfigure Target Device o a f— . e a IC y
Ta end
|l : b=0;
: Design | Files || Libraries | £ Design Summary {ouk of date) | prvni_obvod.w
Console
Started : "Launching IZE Text Editor to edit test.w™. #1001

a=4'nF; /I hexadecimalne
:"(E;:uns_nle Errors“ [ Warnings b — 'hF;

Edit the properties for the highlighted source
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Simulace tohoto obvodu v prostfedi Xilinx IDE

22 ISE Project Navigator - C:\Documents and Settings\XPMUser\projects_xilinx\pryni_cviceni\pryni_cviceni.xise - [test.v]

File Edit Wiew Projeck  Source  Process  Toaols  Window  Help
DPED L XDDX we R AARXAPRNBE DI SR BEL]Q
| Design 08 x = i 47 1 A

B Sources for; [Behavioral Simulation <« M p=| 198
49 initial begin

=] | Hierarch
£| : — 50 /4 Initialize Inputs
HEJ _ 'E':j prvni_cviceni a 51 ——

= £ %c3s50-5pgR0s s2 b = O:

9.|" O @ o | = ' 1. Vybér: Behavioral Simulation

b : <}
= WA= prevni_ob-ad fpevhd obv G /4 Wait 100 ns Ior global Lefet Lo Linich
él 55 i00;
# A 56 N
% 57 A4 hdd stimlug gr_e Vyber SOUboru: teSt
g f 58 a = 4'b0000;
- : | =9 b = 4'b1111;
= e 2l 3| 0
?t Processes; test 61 #1?0; . . R
|o P sn s e e 15 3. Simulate Behavioral Model
= i PAED Behavioral Check Syntax :i =i .
E I = cimate cehavioal odel B S pue — (Behavioral Check Syntax se provede
m 66 a = 4'hF; :
- il automaticky)
(1= ] |
==}
Ta end v
< | 5 st
i_Design :_!:_”!3§ I Libraties | | E  Design Summary {ouk of date) ‘ prvni_obrod, | kest.y
Console - - t - : . ; I
Started : "Launching IZE Text Editor to edit test.w™.
< |

! Console Errars | ‘Warnings |

LnlColl Werilog
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Simulace tohoto obvodu v prostredi Xilinx IDE

ma 15im - [Default.wcfg®]
@ File Edit  Wew Simulation  Window  Help = hE X

N E & X X® wao M BTEM: AN @A ~ < @ b %1000 v Gz
Instances and Proce... + O & X| Objects +08 x| & --
glal@lcls | = » Sirnulation Objects For besk 2 e
i [ I 1 -é oo oI Mame || Yalue | LN I L
Instance and Process Mame _‘i‘ _‘}q‘ @.& @ = = L, i " poon
ﬁ test Ohject Mame Yalue Daka Tvpe = i
41 gl &g vl 1111 Array
&g vz 1111 Array
@ v3 0000 Array
9 ve 0ooo array l
95 v ] Array o] 1111
& a 1111 Array _ T
Bjb 1111 Array i
0000
0000
1111
1111 1111
£ > £ b
Inskances and Pro... Saur.. 4 2| Defaulk wefg* |
Console +O0&F X

W ARMIMG: A WEBPACK license was found,
W ARMING: Please use xilinx License Configuration Manager to check out a Full ISim license,

W ARMING: ISim will run in Lite mode. Please refer to the ISim documentation For more information on the differences between the Lite and the Full version,
This is a Lite wersion of ISim,

Time resolution is 1 ps

Sirnulatar is doing circuit initialization process.,

E'i_;i;s:id circuit initialization process. Vys I ed e k SI m U |aCe L]

Console Breakpoints Search Results

Sim Time ¢ 1000 ns
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